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INTRO
The Pixel Perfect Precision Handbook is now four years old. Over
that time we’ve shifted the focus away from pure pixels and started
to cover more about how we work as well — the new chapter on
Design and Development is a perfect example of this. Even though
our portfolio is incredibly diverse, from mobile banking apps to
physics-defying puzzle games, we always apply the same design
principles that we talk about in the following pages. Enjoy!
Product photo: Monument Valley
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THANKS
There’s a few people out there who deserve a shout out. First of all
Shiro, for showing me the true meaning of pixel precision all those
years ago. All the designers out there sharing their knowledge on a
daily basis — you’ve been a great source of both inspiration and
information. Most of all I’d like to thank all my friends at ustwo for
their immense support in creating this handbook!
Product photo: Rando
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THE
CORE
This first section covers core principles and topics that apply to
digital design and its relevant tools. Applicable to both seasoned
professionals and newcomers to the field, it offers a quick start
guide to some of the processes and thinking that we apply to our
projects here at ustwo.

Pixel Perfect Precision
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PIXEL
PERFECT
PRINCIPLES

Users

Pixel Perfect Precision

Your primary consideration should always be

completely flat, cutting edge interface guided

your users. Guide design decisions by finding

by grids and typography may work for a

out what they want to do, and then structure

younger audience, but perhaps some friendlier

your product so they can carry out that task as

skeuomorphic touches would be more

quickly as possible. Always bear in mind what

appropriate for older users who aren’t quite so

is suitable for them as well; for example, a

tech-savvy.
5

Environment

Environment refers not only to the platform

almost always used indoors, and operated via

you’re designing for, but also how it will be

remote. This in turn means different

operated and the physical space that it will be

considerations for things like text size, colours,

used in. For example, TVs have a completely

and contrast within the interface.

different set of variables to mobile phones —
they are viewed from a much greater distance,
Pixel Perfect Precision
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Random Text
Squeezed in to Fit

Title

Object Description that runs off the edge o
Object Description that runs off the edge o

Object
Description

Object Description that runs off the edge o
Object Description that runs off the edge o
Object Description that runs off the edge o

Object
Description

Object Description that runs off the edge o
Object Description that runs off the edge o
Object Description that runs off the edge o

Object
Description

Object Description that runs off the edge o
Object Description that runs off the edge o
Object Description that runs off the edge o

Naughty
Accessibility

Object
Description

Nice

Accessibility is relevant to every one of your

colour blindness and dyslexia. See the

users — not just those with some kind of

Accessibility chapter for more information.

disability. Good practice such as ease of use
and clarity are a given, but there are also
steps you can take to make your work more
accessible for those with conditions such as
Pixel Perfect Precision
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Title
Object
Description

A Really Long Title
The same here too

Object
Description

A
B

Object
Description
Object
Description

Best-Case
Worst-Case
Scenarios

Longer Title

?

Medium Length
Still fits well
Einen wirklich la…
Das gleiche auch…

Worst-Case

This principle has some ties to accessibility:

blocks of text, translations, missing or highly

make sure your product doesn’t break in real

varied images etc. You can still show off the

situations with real users. We’re all tempted to

pretty version, but have some of these options

put in artwork and text that looks beautiful

available in your files to check now and then.

and impresses clients, but it’s also necessary
to check that your design works with longer
Pixel Perfect Precision

8

Lorem ipsum dolor sit amet,
consectetur adipisicing elit,
sed do eiusmod tempor
incididunt ut labore et dolore
magna aliqua. Ut enim ad
minim veniam, quis nostrud
exercitation ulamco laboris
nisi ut aliquip ex ea commodo
consequat. Duis aute irure
dolor in reprehenderit in
voluptate velit esse cillum
dolore eu fugiat nulla pariatur.
Excepteur sint occaecat
cupidatat non proident, sunt
in culpa qui officia deserunt

Affordance

Affordance is an object’s ability to convey its

digital design to lead users into interacting

function through sensory means, for example

with objects. Commonly used affordances

a button suggests that you press it by being

include buttons which are given depth to

slightly raised; a door handle suggests that

emulate the real world, and text which flows

you pull it by being the right size and position

off the page to show that it scrolls.

for a hand. This technique can also be used in
Pixel Perfect Precision
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Initialisation
Requirements

Hey Matt!

We have detected that this is

Since this is the first time

the first time you have used

you’ve used the app we’re

the application. Before you

going to ask a few questions

start you must answer a

to set things up for you,

series of questions to make

should only take a couple of

sure that everything is set up

minutes. Press the Continue

correctly and works.

button to get started!

Begin

Naughty
Copy

Welcome

Continue

Nice

What you say in your design is just as

emotional connection that results in a better

important as how it looks. Good copy can not

experience with your product.

only make an app easier to understand, but
also gives it personality through the tone of
voice used. Speaking to people like human
beings, rather than machines, creates an
Pixel Perfect Precision
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!

!

i

i

Naughty
Colour and Shape

Nice

Certain colours and shapes have become

but jumbling the two up creates a mixed

synonymous with specific meanings in digital

message. Similarly, yellow and triangles are

design. Be mindful of these norms, as mixing

often associated with warnings, blue and

them up can cause confusion for the user.

circles with information.

Green and ticks are commonly used to
indicate good, likewise red and crosses bad,
Pixel Perfect Precision
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Title
Object

Description
Object

Description
Object

Description
Object

Description

Naughty
Visual Hierarchy

Title
Object
Description
Object
Description
Object
Description
Object
Description

Nice

Layout, colours and typography have a huge

contrast and large, bold type, or push items

influence on what the eye is drawn to, and

back with lower contrast and smaller, lighter

consequently how information is consumed.

type. Culture also plays a part: for example

Think about what you want the user to look at

Westerners will naturally start near the top left

on the page and in what order, then design

of a screen as that’s the way we read.

around that hierarchy. Grab attention with high
Pixel Perfect Precision
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Lorem ipsum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua.
Ut enim ad minim veniam, quis nostrud
exercitation ulamco laboris nisi ut aliquip ex
ea commodo consequat. Duis aute irure
dolor in reprehenderit in voluptate velit
esse cillum dolore eu fugiat nulla pariatur.
Excepteur sint occaecat cupidatat non
proident, sunt in culpa qui officia deserunt
mollit anim id est laborum. Lorem ipsum
dolor sit amet, consectetur adipisicing elit,
sed do eiusmod tempor incididunt ut labore
et dolore magna aliqua. Ut enim ad minim
veniam, quis nostrud exercitation ulamco
laboris nisi ut aliquip ex ea commodo
consequat. Duis aute irure dolor in
reprehenderit in voluptate velit esse cillum
dolore eu fugiat nulla pariatur. Excepteur
sint occaecat cupidatat non proident, sunt
in culpa qui officia deserunt mollit anim id
est laborum. Lorem ipsum dolor sit amet,
consectetur adipisicing elit, sed do
eiusmod tempor incididunt ut labore.

Naughty
Typography

Lorem ipsum dolor sit amet,
consectetur adipisicing elit,
sed do eiusmod tempor
incididunt ut labore et dolore
magna aliqua. Ut enim ad
minim veniam, quis nostrud
exercitation ulamco laboris
nisi ut aliquip ex ea commodo
consequat. Duis aute irure
dolor in reprehenderit in
voluptate velit esse cillum
dolore eu fugiat nulla pariatur.

Nice

Typography is often overlooked in digital

squinting? Is there enough leading and are the

products, but since most information is

line lengths short enough to make reading

conveyed through text it should be high on

comfortable? Don’t just accept the default

your list of priorities. Apply the same basic

font settings in your design environment —

principles as for other mediums: is it a

treat type with the respect it deserves!

comfortable size for reading without
Pixel Perfect Precision
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Title

Title

Object
Description

Object
Description

Object
Description
Object
Description
Object
Description

Enter
Motion

Object
Description
Object
Description
Object
Description

Exit

With the ever-increasing power of hardware

features; for example, if you wanted to draw

it’s now possible to make your designs not

attention to a new button you could make it

only look good, but also move elegantly.

periodically bounce to catch a user’s eye.

Subtle animations can enhance interfaces,
giving them character and increasing their
intuitiveness by hinting to functions and
Pixel Perfect Precision
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Testing

Nothing beats testing designs on their

these days that will take a design from your

intended device. Screen resolution and

computer and place it directly on your device,

technology can vary dramatically compared to

updating in real time as you apply changes.

your computer, as well as other variables like

Make sure to use them!

viewing angles and input methods. There are a
wide range of live previewing tools available
Pixel Perfect Precision
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Movie.avi

Sketch

Demo

Object
Description

Watch me!
I’m going to move

Press me!
I actually work

Object
Description

Static
I don’t move

Inactive
I don’t do anything

Object
Description

Static
I don’t move

Inactive
I don’t do anything

Object
Description

Static
I don’t move

Inactive
I don’t do anything

Prototyping

Pixel Perfect Precision

Movie

Closely linked to testing is prototyping, which

development environment. Pick whichever

is a quick way to try out ideas and designs

suits the feature you want to test; the basic

without investing time and effort into polished

structure of a screen can easily be tested on

versions. There are many forms this can take,

paper, whereas an animated transition may

from simple drawings on paper, right up to

require something mocked up as a video or

building limited apps in the platform’s native

even coded.
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Project
Design
Screen.psd
Assets
Rectangle.png
Square Blue.png
Square Green.png
Square Orange.png
Square Pink.png

Organisation

No man is an island, and most of the time your

logically named set of assets will make

files won’t be either! Good organisation is

developers very happy.

essential as it saves a lot of time for other
people on the project; well ordered files and
layers mean other designers can jump straight
into your work and find their way around, and a
Pixel Perfect Precision
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Take a Break

It’s very easy to get completely consumed in

After coming back the solution to a design

the design process, but sometimes it pays to

problem might be staring you right in the face,

take a break — not just for health reasons, but

or you might spot a flaw that had previously

also the different perspective a refreshed set

gone unnoticed!

of eyes can bring. Go and make a brew, or
wander somewhere else for a few minutes.
Pixel Perfect Precision
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PIXEL
PERFECT
DETAILS

Naughty
Sharp Edges

Pixel Perfect Precision

Nice

Straight edges should be on-pixel and sharp
— blurred edges are a no-no!

20

y

y

y

x

Naughty
Alignment and
Spacing
Pixel Perfect Precision

x

Nice

Once you’ve mastered the art of getting
everything sharp, the next step in your journey
towards pixel perfection is making sure the
alignment and spacing are right.

21

Consistency

Alignment of objects across multiple screens

to set up a grid, which will define a structure

is just as important. Margins and placement of

that can be followed throughout your screens.

common items such as title bars, back
buttons, and footers should be the same
throughout the interface to prevent objects
jumping around. The best way of doing this is
Pixel Perfect Precision
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H

0°

300°

60°
Hue

240°

120°

S
0%

352

352

Saturation

95

22

45

95

Brightness

90

98

95

45

230

249

242

116

Green

12

194

133

6

Blue

41

201

148

20

100%
B

Colour Model

352

Red

180°

0%

352

100%

HSB FTW! Have a go at using HSB as a colour

Brightness (B) adjusted to create the

model when creating a palette — once it

variations. See how much more sense the

clicks you’ll see it’s a really efficient way to

numbers make in HSB compared to RGB?

create different shades of a base colour. In the
example above the Hue (H) value has been
kept the same, then the Saturation (S) and
Pixel Perfect Precision
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Colour Profile

Yes

No

Code

Naughty
Colour
Management
Pixel Perfect Precision

Nice

Colour management makes a lot of sense in

they’re mixed with unmanaged code

print environments, but for digital often

(specifying the same original colours) there

creates more problems than it solves. The

can be a mismatch. It’s much better to ignore

main issue is a lack of availability throughout

this procedure altogether, and instead test on

the development process — you can manage

the device — unlike print this takes a matter of

colours when creating assets, but when

seconds and costs nothing!
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Åy

WWW

Max. Height

Max. Width

Text Height and
Width

These two tips are handy for creating designs

limit with a series of capital Ws — if they fit

based on dynamic text, such as translations or

then any other phrase will too.

user-generated content. To find a line of text’s
maximum possible height use the Åy combo;
similarly, if a text box needs to accommodate
a minimum number of characters then fill that

Pixel Perfect Precision
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Settings
Einstellungen
Configurações
Text Length

If you’re working on a product that will be used
internationally then consider how long the text
content could be in other languages. The
example above shows what happens with the
German and Portuguese translations of
Settings — an increase of up to 75% in length.

Pixel Perfect Precision
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Align Text

Align Text

Align Text

Align Text

Align Text

Align Text

ABC123

ABC123

ABC123

Cap Height and Descender

x-height

Cap Height and x-height

Aligning Text on
Buttons

Shown above are three ways to vertically align

mixture of all three. Make sure that once you

text on buttons. Which method is best

pick a rule you stick to it throughout the

depends on a few variables, such as the

interface — consistency is king!

choice of typeface (for example the cap height
to x-height ratio can vary) and whether you’re
using uppercase, lowercase, numbers, or a

Pixel Perfect Precision
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Aligning Text with
Objects

Align Text

Align Text

Align Text

Align Text

Naughty

Nice

Try to vertically centre text to an object using

The exception to this rule is text fixed to all

the x-height, rather than the cap height, as it

caps or numbers — these can be aligned by

gives a better optical alignment. In the

cap height as they won’t feature descenders.

Naughty example above you can see that the
main visual weight of the typeface, located in
the x-height area, sits lower than the square.

Pixel Perfect Precision
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Active
Selected
Disabled

Object States

Remember that interactive elements will likely

them as an afterthought — that way you can

need some extra states in addition to the

make sure their styling fits in with the rest of

default one you provide in a mockup. These

the design and works on an interaction level.

can vary depending on the platform and input
method, but in any case try mocking them up
while creating your design rather than leaving
Pixel Perfect Precision
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Button

Button

Button

Outer = Inner

Inner Scaled

Outer = Inner + Border Width

Borders and
Corner Radii
Pixel Perfect Precision

Interface components often need some kind of

inner and the outer radii, scaling the original

border, the straight edges are easy enough to

shape in size, and adding the border and

do, but what’s the best way to work out the

original inner radius together. The latter is by

outer corner radii based on the inner? There

far the best method, resulting in consistent

are a few methods available, the most

outlines that don’t thicken at the corners like

common being shown above — matching the

the other two.
30

Borders and
Corner Radii
Filleting
Pixel Perfect Precision

Button

Button

Inner = Outer − Border Width

Filleted

If you use the preferred method from the

mathematically “incorrect” it may look better

previous page, but reverse the process by

from a visual perspective. In the engineering

starting from the outer radii, you could end up

world this process is known as filleting, with

with corners on the inner shape that are

each individual corner called a fillet. Check out

completely square. In these situations

Ra Design’s in-depth article on borders and

consider adding a small radius back in, though

corner radii to learn more about this subject.
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100%

100%

Naughty
Equilateral
Triangles

86.6%

100%

Nice

Some graphics applications draw triangle
shapes that aren’t equilateral by default, but
instead use the same measurements for both
x and y dimensions. To quickly convert to an
equilateral scale the height (with the shortest
edge at the bottom) by 86.6%.

Pixel Perfect Precision
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Project

Project

Screen_1.psd
Screen_2.psd

Screen_140401_r01.psd

Screen_FINAL.psd

Screen_140402_r01.psd

Screen_FINAL_FINAL.psd

Screen_140402_r02.psd

Screen_FINAL_FINAL_2.psd

Screen_140402_r03.psd

Screen_FINAL_FINAL_3.psd

Screen_140403_r01.psd

Screen_Latest_1.psd

Screen_140403_r02.psd

Screen_Latest_2.psd

Naughty
Version Control

Pixel Perfect Precision

Archive

Screen.psd

Nice

Although there are now a multitude of version

most recent file, Screen.psd, is kept at the top

control applications available for designers,

level of the working folder. At the start of the

more often than not we still end up managing

day and other key moments, that file will be

files and revisions ourselves. Doing this

duplicated, placed in the Archive folder, and

manually is more time consuming, but using a

given a filename based on the date (YYMMDD

system like the one shown above will help. The

works best) and revision number. Tidy!
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ACCESSIBILITY

“

If I make my design
accessible, won’t it
look rubbish?

Accessibility

Accessibility doesn’t mean compromise for

pixel perfect precision, if these principles are

those with disabilities, but instead good,

built into your design process from the start,

inclusive design for everyone. There’s no need

then you’ll find that making your product

for huge sacrifices in terms of visual appeal, or

accessible takes very little time at all.

dramatic amounts of extra time and money to
make everything comply to standards. Like
Pixel Perfect Precision
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Types of
Impairment
Pixel Perfect Precision

Around 10% of the UK population have some

three senses. Don’t rely on one sense alone to

form of disability, which is a significant

make your product or feature usable, but

number of potential users. There are four main

instead allow multiple forms of interaction and

types of impairment that will commonly affect

communication where possible — for example

digital projects: sight, hearing, touch and

enabling text-to-speech functions for visually

cognitive i.e. the ability to process those other

impaired users.
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A Title That Is Far Too
Long for This Screen…

Title

Title

Object
Description

Object
Description

Object Description that runs off the edge o
Lorem ipsum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua.
Ut enim ad minim veniam, quis nostrud
exercitation ulamco laboris.
Object Description that runs off the edge o
Lorem ipsum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua.
Ut enim ad minim veniam, quis nostrud
exercitation ulamco laboris.
Object Description that runs off the edge o
Lorem ipsum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor

Object
Description

amet, consectetur
adipisicing elit, sed do
eiusmod tempor incididunt

Object
Description

ut labore et dolore magna
aliqua. Ut enim ad minim
veniam, quis nostrud

Object
Description

Naughty
Clarity

Lorem ipsum dolor sit

exercitation ulamco laboris.

Nice
Keep designs as clear and concise as possible

needed. It’s also important to make your

to avoid overloading the user with too much

content suitable for mobile devices — for

content. You can do this by showing

example keeping image sizes small for those

information which is relevant to the context of

on data connections.

the user, and then utilising progressive
disclosure to reveal more details as they are
Pixel Perfect Precision
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OS

App

App

Title
Subtitle

Object
Description

Object
Description

Lorem ipsum dolor sit

Object
Description

amet, consectetur

ut labore et dolore magna

Object
Description

exercitation ulamco laboris.

Consistency

Pixel Perfect Precision

eiusmod tempor incididunt
ut labore et dolore magna
aliqua. Ut enim ad minim

aliqua. Ut enim ad minim
veniam, quis nostrud

amet, consectetur
adipisicing elit, sed do

adipisicing elit, sed do
eiusmod tempor incididunt

Lorem ipsum dolor sit

Object
Description

veniam, quis nostrud
exercitation ulamco laboris.

Your designs should maintain consistency

from the host operating system — this means

across a number of levels, including style,

that users can predict how the product will

navigation, typography, and use of language.

behave, based on past experiences with the

Interface elements should act in a standard

platform. Most major devices have guidelines

way whenever they appear, and where

for their design and interaction patterns — so

possible follow any conventions or patterns

check those out.
38

Title

Title

Object
Description

Object
Description

Object
Description

Lorem ipsum dolor sit
amet, consectetur

Title
Object
Search results
Object
Description

adipisicing elit, sed do
Object
Description

eiusmod tempor incididunt
ut labore et dolore magna

Object
Description

aliqua. Ut enim ad minim
Object
Description

Navigation

veniam, quis nostrud
exercitation ulamco laboris.

Object
Description

As mentioned on the previous page,

other parts of the interface, for example, if a

navigation should behave consistently as it

button performs a certain action in one part of

will help users move around your app without

the app, then it should do the same when

feeling lost. Position navigational elements in

activated elsewhere.

the same places across all screens, with the
same styles and labels. This also applies to
Pixel Perfect Precision
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Title
Lorem ipsum dolor sit
amet, consectetur

Title

i

Some really useful
information here!

adipisicing elit, sed do
eiusmod tempor incididunt

Lorem ipsum dolor sit

ut labore et dolore magna

amet, consectetur

aliqua. Ut enim ad minim

adipisicing elit, sed do

veniam, quis nostrud

eiusmod tempor incididunt

exercitation ulamco laboris

ut labore et dolore magna

nisi ut aliquip ex ea

aliqua. Ut enim ad minim

commodo consequat.

veniam, quis nostrud
exercitation ulamco laboris.

i

Some really useful
information here!

Naughty
Navigation
Content Structure

Nice

When creating the layout for a page, really
think about why the user is there and what
they’re looking for. Based on that, structure
your content in such a way that the most
important parts are the easiest to reach.

Pixel Perfect Precision
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Hi!

…then this

…and finally

Hit the link at

link…

this one here.

the bottom
for the info…
Info

i
What you

Info

Info

were after!

Naughty
Navigation
Minimise Steps

Hi!
Hit the link at
the bottom
for the info…
Info

i
Much easier
to get to!

Nice

Although cramming everything on to one
screen isn’t a great idea, be mindful that by
introducing too many steps you can create
hassle for your users. Try to make all
information accessible within four pages —
any more can cause frustration.

Pixel Perfect Precision
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Object
Description

Object
Description

Object
Description

Object
Description

Naughty
Navigation
Titles
Pixel Perfect Precision

Title
Object
Description
Object
Description
Object
Description
Object
Description

Nice

Clearly title pages so that users know where
they are, as well as the context of the
information presented to them.
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Title

Title

Object
Description

Object
Description

Lorem ipsum dolor sit

Lorem ipsum dolor sit

amet, consectetur

amet, consectetur

adipisicing elit, sed do

adipisicing elit, sed do

eiusmod tempor incididunt

eiusmod tempor incididunt

ut labore et dolore magna

ut labore et dolore magna

aliqua. Ut enim ad minim

aliqua. Ut enim ad minim

veniam, quis nostrud.

veniam, quis nostrud
exercitation ulamco laboris
nisi ut aliquip ex ea
commodo consequat. Duis
aute irure dolor in.

Naughty
Navigation
Appropriate Page
Sizes
Pixel Perfect Precision

Nice

Keep your content to an appropriate page size

pages too long though, as no one likes to

and try to introduce breaks where it makes

endlessly flick up!

sense. Scrolling through a page is much easier
than linking between them, it also reduces the
amount of page requests which will be
beneficial to mobile users. Don’t make the
43

Title

Title

Object
Description

Object
Description

Lorem ipsum dolor sit amet,

Lorem ipsum dolor sit

consectetur adipisicing elit, sed do

amet, consectetur

eiusmod tempor incididunt ut labore

adipisicing elit, sed do

et dolore magna aliqua. Ut enim ad

eiusmod tempor incididunt

minim veniam, quis nostrud

ut labore et dolore magna

exercitation ulamco laboris nisi ut

aliqua. Ut enim ad minim

aliquip ex ea commodo. consequat.

veniam, quis nostrud

Duis aute irure dolor in reprehenderit

exercitation ulamco laboris

in voluptate velit esse cillum dolore eu

nisi ut aliquip ex ea

fugiat nulla pariatur. Excepteur sint

commodo consequat. Duis

occaecat cupidatat non proident sunt.

aute irure dolor in.

Naughty
Navigation
Limit Scrolling to
One Direction
Pixel Perfect Precision

Nice

Make sure your content only scrolls in one
direction — it’s easier both physically and
mentally for users, as they won’t have to pan
around trying to keep track of what they have
and haven’t seen.
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Pink
Orange
Green
Blue
Naughty
Navigation
Numbered Lists
Pixel Perfect Precision

1.
2.
3.
4.

Pink
Orange
Green
Blue
Nice

If you’ve got more than three or four points in a
list, consider using numbers instead of bullets
as these provide some structure, which aids
navigation through the content.

45

Action

“

This is a button
that initiates Action.
By pressing it you will
proceed to the next
screen of the app.

Naughty
Navigation
Labelling

Action

“

Go to next screen

Nice

Creating labels for text-to-speech functions is
an art form in itself. Make descriptions clear,
so that users know what’s going on, but also
concise so they don’t have to spend ages
listening to them.

Pixel Perfect Precision
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Name
Gyppsy
Enter email address

Gyppsy
Email
Enter here

“

Gyppsy. Enter email
address.

Naughty
Navigation
Labels Above
Input Fields
Pixel Perfect Precision

“

Name Gyppsy. Email
Enter here.

Nice

Place labels above input fields rather than in
them, as once there’s an entry in the latter, a
screen reader won’t make as much sense to
the user — it will only output the value
entered, not the field name.
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7mm
7mm

Naughty
Interaction
Touch Targets

Nice

When creating designs for touch-based

then leave at least a 2mm gap between items

devices, always consider how easy they are to

so they don’t get pressed accidentally. If

operate using fingers and thumbs. We usually

you’ve got components that will be primarily

base our designs on a minimum touch area of

thumb-operated, then make those wider, as

7mm × 7mm, which is the rough size of the

the average width of an adult thumb is 25mm.

contact area between a finger and screen, and
Pixel Perfect Precision
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Action

Naughty
Interaction
Buttons and
Hyperlinks
Pixel Perfect Precision

Action

Nice

Buttons are the commonly accepted method
of initiating actions in applications, so opting
for hyperlinks instead will confuse the user.
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This is not
a link

Naughty
Interaction
Buttons and
Hyperlinks
Pixel Perfect Precision

This is not
a link

Nice

And talking of hyperlinks, don’t underline text
that isn’t a link, as again this can cause
confusion. Users may think something is
wrong when they tap it and nothing happens.
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Delete Files

Delete Files

File 1

File 1

File 2
File 3
To delete the items tick the
box below and press Delete

File 4
Yes

I want to delete them

File 5

Delete

Error Prevention
Design
Pixel Perfect Precision

Deleting
File 2 these files will
permanently remove
them. Are you sure you
File 3
want to do that?
No

Delete

It’s well worth trying to minimise errors that

using warnings and confirmations as methods

can occur while using your product. One of the

to prevent errors; and providing fail-safes

best ways to do that is through design. There

should anything go wrong. Also, try to make

are various techniques available, such as

users think about what they’re doing in

placing useful elements at the fore and

important situations, rather than allowing

isolating or hiding those that can be risky;

them to cruise through on autopilot.
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Name

Name

Gyppsy

Gyppsy

Telephone

Telephone

01234 56789

01234 56789

!

Invalid number
Submit

Naughty
Error Prevention
Checked Data
Pixel Perfect Precision

Submit

Nice

It’s sometimes difficult to input data on mobile
devices due to their small size, so giving users
an indication that what they’re entering is
correct can be really useful.
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Colour
Select colour
Colour

Pink

Enter colour

Orange
Green
Blue

Naughty
Error Prevention
Free Text
Pixel Perfect Precision

Nice

Where possible provide default values rather
than free text entry, as it will reduce the
chance of input errors.
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Select Items
Item 1
Item 2
Item 3
Item 4
Item 5

Buy

Error Prevention
Review, Confirm,
and Correct
Pixel Perfect Precision

Review
You’ve chosen these items:
Item 1
Item 2
Item 3
Item 4
Item 5
Press Confirm Purchase to
buy them, or use the back
button to change.

Confirm Purchase

When users are entering data as part of a
process, give them an opportunity to review it
before submitting, as well as the option to go
back and correct if necessary.
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Delete Files

Trash

File 1

File 3

File 2

File 4

File 3
File 4
File 5

Delete

Error Prevention
Reversible
Submissions
Pixel Perfect Precision

Restore

If your app allows people to carry out

which allows users to step back in time to a

hazardous procedures, such as deleting their

previous revision.

content, then provide some way of undoing
that process if needed. This might be in the
form of a trash folder that only gets emptied
once a week, or some kind of version control
55

Do you wish to
cancel this order?
OK

Cancel

Naughty
Copy

Do you wish to
cancel this order?
Yes

No

Nice

It’s not just how your type looks but what it

would you select Cancel to cancel the order, or

says that’s equally, if not more important.

does it cancel the cancel?

Unclear labelling or instructions confuse
users, so spend time thinking about what
you’re trying to communicate and if it’s being
done effectively. In this Naughty example
Pixel Perfect Precision
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Lorem ipsum dolor sit amet, consectetur
adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua.

incididunt ut labore et dolore magna aliqua.
Ut enim ad minim veniam, quis nostrud

exercitation ulamco laboris nisi ut aliquip

exercitation ulamco laboris nisi ut aliquip

ex ea commodo consequat. Duis aute irure

ex ea commodo consequat.

esse cillum dolore eu fugiat nulla pariatur.
Excepteur sint occaecat cupidatat non
proident, sunt in culpa qui officia deserunt
mollit anim id est laborum.

Naughty

Pixel Perfect Precision

adipisicing elit, sed do eiusmod tempor

Ut enim ad minim veniam, quis nostrud

dolor in reprehenderit in voluptate velit

Copy
Break Up Large
Blocks of Text

Lorem ipsum dolor sit amet, consectetur

Duis aute irure dolor in reprehenderit in
voluptate velit esse cillum dolore eu fugiat
nulla pariatur. Excepteur sint occaecat
cupidatat non proident, sunt in culpa qui
officia deserunt mollit anim id est laborum.

Nice

Break up large blocks of text so they’re easier
to digest and keep track of. Use around 5 lines
as a maximum and you’ll not go far wrong.
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1. Pink — Lorem ipsum dolor sit amet,
consectetur adipiscing elit. Fusce

1.

Pink

2.

Orange

3.

Green

4.

Blue

pellentesque vehicula elit sed tincidunt.
Nam bibendum tempus tellus ac interdum.
2. Orange — Lorem ipsum dolor sit amet,
consectetur adipiscing elit. Sed fermentum
sodales orci. Class aptent taciti sociosqu
ad litora torquent per conubia nostra, per
inceptos himenaeos. 3. Green —
Pellentesque a nibh nibh, vel dictum risus.
4. Blue — Nunc congue vestibulum nibh
non sollicitudin. Donec eget metus leo.

Naughty
Copy
Text to Diagrams

Nice

Some users, such as dyslexics, can have poor
organisational skills, so consider breaking
down long paragraphs of text into lists or
diagrams, which help them by showing the
information in smaller, ordered chunks.

Pixel Perfect Precision
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PPP

Naughty
Copy
Abbreviations

PPP
(Pixel Perfect
Precision)

Nice

If you’re using abbreviations make sure to
include their expansion on first use. Better still
try to avoid them altogether, as remembering
what they stand for can prove difficult for
some users.

Pixel Perfect Precision
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Click here

Naughty
Copy
Link Text
Pixel Perfect Precision

Pixel Perfect
Precision
Handbook
(25MB)
Nice

“Click here” works well enough as a link, right?

describe its destination, as well as make

Wrong! Not only does it contain zero

sense in isolation. Users will often scan a page

information on where the link leads to, but

and pick out links which might lead them to

also most touchscreen users won’t even have

the content they’re after. Also include any

a mouse to “click” with. Since it’s a form of

other relevant details that might be useful,

navigation, the text should instead clearly

such as the download size if it points to a file.
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Loading

Naughty
Feedback

Nice

Give users some feedback when they're

situations could be in the form of spinners and

performing tasks so they feel reassured.

messages that notify users of what's

There's nothing more annoying than

happening, or pressed states and sounds to

wondering if an app's frozen when it pauses to

reinforce that they’ve initiated an action.

process a request, or pressing buttons that
don't seem to do anything. Feedback in these
Pixel Perfect Precision
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!

!
!
Alert

Naughty
Feedback
Multi-sensory

Nice

Provide feedback in multiple forms where
possible. For example, relying solely on sound
for an alert would mean that deaf users, or
those located in noisy environments, wouldn’t
be aware that something has happened which
requires their attention.

Pixel Perfect Precision
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Error code 04 type 11
An error has occurred in
the bus_1234 Library.
This problem has caused
a crash in the dynamic
states of the system.
Please contact your sys
admin on the IT floor.

Something went wrong!
But don’t worry, press
Return to go back to the
previous screen.

Return

OK

Naughty
Feedback
Error Messages
Pixel Perfect Precision

Nice

If something goes wrong let the user know
what’s happened in an understandable way,
and provide them with the option to navigate
back to somewhere useful.
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! You work at ustwo
Name

Name

Gyppsy

Gyppsy

Company

Company

usthree

usthree

!

You work at ustwo

Naughty
Feedback
Error Proximity
Pixel Perfect Precision

Nice

When designing forms, place error messages
next to the relevant field rather than far away,
as this will help users identify the problem
more quickly.
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Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Fusce pellentesque vehicula elit
sed tincidunt. Nam bibendum tempus tellus ac
interdum. Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Sed fermentum sodales orci. Class
aptent taciti sociosqu ad litora torquent per
conubia nostra, per inceptos himenaeos.
Pellentesque a nibh nibh, vel dictum risus. Nunc
congue vestibulum nibh non sollicitudin. Donec
eget metus leo, eleifend tempus enim. Lorem
ipsum dolor sit amet, consectetur adipiscing elit.
Fusce pellentesque vehicula elit sed tincidunt.
Nam bibendum tempus tellus ac interdum. Lorem
ipsum dolor sit amet, consectetur adipiscing elit.
Sed fermentum sodales orci. Class aptent taciti
sociosqu ad litora torquent per conubia nostra, per
inceptos himenaeos. Pellentesque a nibh nibh, vel
dictum risus. Nunc congue vestibulum nibh non
sollicitudin. Donec eget metus leo, eleifend
tempus enim.

Naughty
Typography

Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Fusce pellentesque vehicula
elit sed tincidunt. Nam bibendum tempus
tellus ac interdum. Lorem ipsum dolor sit
amet, consectetur adipiscing elit. Sed
fermentum sodales orci.
Class aptent taciti sociosqu ad litora
torquent per conubia nostra, per inceptos
himenaeos. Pellentesque a nibh nibh, vel
dictum risus. Nunc congue vestibulum nibh
non sollicitudin. Donec eget metus leo.

Nice

As mentioned in Pixel Perfect Principles, good

keeping text light and legible you’ll help these

typography is vital in digital design, and has a

users navigate easily from one line to the next.

great effect on your product’s accessibility.
The basics of good line length and leading are
just as relevant for this medium, especially for
those with visual or cognitive impairments. By
Pixel Perfect Precision
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Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Fusce pellentesque vehicula
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Fusce

elit sed tincidunt. Nam bibendum tempus

pellentesque vehicula elit sed tincidunt. Nam bibendum tempus

tellus ac interdum. Lorem ipsum dolor sit

tellus ac interdum. Lorem ipsum dolor sit amet, consectetur

amet, consectetur adipiscing elit. Sed

adipiscing elit. Sed fermentum sodales orci.

fermentum sodales orci.

Class aptent taciti sociosqu ad litora torquent per conubia
nostra, per inceptos himenaeos. Pellentesque a nibh nibh, vel

Class aptent taciti sociosqu ad litora

dictum risus. Nunc congue vestibulum nibh non sollicitudin.

torquent per conubia nostra, per inceptos

Donec eget metus leo.

himenaeos. Pellentesque a nibh nibh, vel
dictum risus. Nunc congue vestibulum nibh
non sollicitudin. Donec eget metus leo.

Naughty
Typography
Font Size

Nice

The minimum font size you should be using is
12pt, with a good reading size around 16pt
(1em). Make text too small and users will be
straining to see what it says, especially on
lower density screens which aren’t that sharp.
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Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Fusce pellentesque vehicula
elit sed tincidunt. Nam bibendum tempus
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Fusce pellentesque vehicula elit sed tincidunt. Nam
bibendum tempus tellus ac interdum. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Sed fermentum
sodales orci. Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos.
Pellentesque a nibh nibh, vel dictum risus. Nunc congue vestibulum nibh non sollicitudin. Donec eget metus
leo, eleifend tempus enim. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Fusce pellentesque
vehicula elit sed tincidunt. Nam bibendum tempus tellus ac interdum. Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Sed fermentum sodales orci. Class aptent taciti sociosqu ad litora torquent per conubia nostra,
per inceptos himenaeos. Pellentesque a nibh nibh, vel dictum risus. Nunc congue vestibulum nibh non
sollicitudin. Donec eget metus leo, eleifend tempus enim.

tellus ac interdum. Lorem ipsum dolor sit
amet, consectetur adipiscing elit. Sed
fermentum sodales orci.
Class aptent taciti sociosqu ad litora
torquent per conubia nostra, per inceptos
himenaeos. Pellentesque a nibh nibh, vel
dictum risus. Nunc congue vestibulum nibh
non sollicitudin. Donec eget metus leo.

Naughty
Typography
Line Length

Nice

Keep line lengths below 80 characters wide. If

discussed in Robert Bringhurst’s The

any longer a user will find it difficult to gauge

Elements of Typographic Style).

where the start and end points of each line
are, making text harder to read. A good range
to aim for is 45–75 characters, with the
optimum length being 66 including spaces (as

Pixel Perfect Precision
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Lorem ipsum dolor sit amet, consectetur
Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Fusce pellentesque vehicula
elit sed tincidunt. Nam bibendum tempus
tellus ac interdum. Lorem ipsum dolor sit
amet, consectetur adipiscing elit. Sed
fermentum sodales orci.
Class aptent taciti sociosqu ad litora
torquent per conubia nostra, per inceptos
himenaeos. Pellentesque a nibh nibh, vel
dictum risus. Nunc congue vestibulum nibh
non sollicitudin. Donec eget metus leo.

adipiscing elit. Fusce pellentesque vehicula
elit sed tincidunt. Nam bibendum tempus
tellus ac interdum. Lorem ipsum dolor sit
amet, consectetur adipiscing elit. Sed
fermentum sodales orci.
Class aptent taciti sociosqu ad litora
torquent per conubia nostra, per inceptos
himenaeos. Pellentesque a nibh nibh, vel
dictum risus. Nunc congue vestibulum nibh
non sollicitudin. Donec eget metus leo.

Naughty
Typography
Spacing

Nice

Giving lines of text enough space allows the

line spacing, the break between paragraphs is

eye to clearly see each one, which helps with

also made obvious.

the flow of reading. The recommended line
spacing (otherwise known as leading) is 1.5
times the type size — similarly, by then
making the paragraph spacing 1.5 times the

Pixel Perfect Precision
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Lorem ipsum dolor sit amet, consectetur

Lorem ipsum dolor sit amet, consectetur

adipiscing elit. Fusce pellentesque vehicula

adipiscing elit. Fusce pellentesque vehicula

elit sed tincidunt. Nam bibendum tempus

elit sed tincidunt. Nam bibendum tempus

elit sed tincidunt. Nam bibendum tempus

tellus ac interdum. Lorem ipsum dolor sit

tellus ac interdum. Lorem ipsum dolor sit

tellus ac interdum. Lorem ipsum dolor sit

amet, consectetur adipiscing elit. Sed

amet, consectetur adipiscing elit. Sed

fermentum sodales orci.

fermentum sodales orci.

Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Fusce pellentesque vehicula

amet, consectetur adipiscing elit. Sed
fermentum sodales orci.

Class aptent taciti sociosqu ad litora

Class aptent taciti sociosqu ad litora

torquent per conubia nostra, per inceptos

torquent per conubia nostra, per inceptos

torquent per conubia nostra, per inceptos

himenaeos. Pellentesque a nibh nibh, vel

himenaeos. Pellentesque a nibh nibh, vel

himenaeos. Pellentesque a nibh nibh, vel

dictum risus. Nunc congue vestibulum nibh

dictum risus. Nunc congue vestibulum nibh

non sollicitudin. Donec eget metus leo.

non sollicitudin. Donec eget metus leo.

Naughty
Typography
Alignment

Class aptent taciti sociosqu ad litora

dictum risus. Nunc congue vestibulum nibh
non sollicitudin. Donec eget metus leo.

Nice

Multiple lines of text should always be leftaligned, as the inconsistent spaces in justified
and centred text can be a problem for users
with learning difficulties. Justification also
creates distracting white rivers running
through the paragraphs.
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Example
Example
Example
EXAMPLE

Example
Example

Naughty
Typography
Formatting

Nice

Keep text formatting as simple as possible to

whole sentences or paragraphs also makes

gain the best legibility for your users. Serif

text more difficult to read AND LOOKS LIKE

type is harder to read for visually impaired or

YOU’RE SHOUTING!

dyslexic users, as its styling can obscure the
shape of the letters — likewise, italics and
underlines add visual noise. Capitalisation of

Pixel Perfect Precision
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Example
Example
Naughty
Typography
Formatting
Pixel Perfect Precision

Nice

Lastly, avoid moving or blinking text, as
visually impaired and dyslexic users can find
this very distracting. Also worth noting that
these effects can trigger epileptic seizures.
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Exa…
Exa…
Exa…
Naughty
Typography
Truncation
Pixel Perfect Precision

Example 1
Example 2
Example 3
Nice

Truncate text only where necessary, as it hides
useful content.
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Example

+

Example

Naughty
Typography
Merging Text with
Graphics
Pixel Perfect Precision

Nice

Wherever possible, try not to merge text with

both of which aren’t possible when embedded

graphics and instead implement at a code

into a graphic.

level. This separation means words can be
recognized by text-to-speech functions and
read out loud, or have their size and colour
changed according to the user’s preference —
73

Information

Naughty
Colour
Visual Aids

i Information

Nice

Try to give users visual aids such as icons and

useful for those with cognitive impairments.

colours to help them identify important

Make sure it’s used consistently though!

content on a page. Colour coding is also a
handy way to identify different types of
content — something which can be especially

Pixel Perfect Precision
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Passed
Failed

Naughty
Colour
Don’t Rely on
Colour Alone
Pixel Perfect Precision

Nice

However, don’t rely on colour alone to convey

Also bear in mind that approximately 8% of

a message, always include a secondary

males have some form of colour blindness,

method as well. Some mobile devices suffer

affecting their ability to distinguish between

from poor colour contrast, or are used in less

certain hues — they would have difficulty

than ideal lighting situations, both of which

telling the difference between the two

can reduce the impact and visibility of colours.

Naughty shapes based on colour alone.
75

Naughty
Colour
Alternatives

Nice

If you’re using colour to present information,
such as the bars in a graph, then introduce a
secondary method to distinguish between
them. In this case patterns have been applied
to the orange and blue areas.
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Example

Example

Naughty
Colour
Colour Contrast

Nice

Good contrast between text and background

make sure there’s still enough contrast in real-

colours is the best way to make sure that

world situations.

important information is still visible for users
with some form of colour blindness or visual
impairment. Also check designs on an actual
device in non-ideal lighting conditions, to

Pixel Perfect Precision
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AA
Foreground

AA (Large)

Background

AAA
AAA (Large)

Colour
Colour Contrast
Checkers
Pixel Perfect Precision

There are numerous tools out there for testing

standards. AAA is better, needing a lot more

colour contrast. A couple of great options are

contrast, but too much could have a negative

Colour Contrast Analyser and Jonathan

impact on your designs. The tests also

Snook’s web-based checker — in either case

differentiate between body sized copy and

just pop in the two colours and away you go!

“Large” text, which is 18pt+ (or bold and larger

As a minimum you should aim to pass AA

than 14pt).
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Red /
Magenta

Colour
ColorADD

Yellow

Blue /
Cyan

White

Black

If you had to describe colours without using

subtractive light, you can create the whole

text labels, what would you do? Turns out a

spectrum — just as you would with paint or

great solution already exists, ColorADD is a

ink. It’s also possible to make light and dark

simple system that represents colours using

shades of those colours, by merging them with

symbols. By combining these symbols, which

the symbols for black and white.

stand for the three primary colours in
Pixel Perfect Precision
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Colour
ColorADD
Pixel Perfect Precision

Pink

Light
Orange

Light
Yellow

Light
Green

Light
Blue

Orchid

Khaki

Red

Orange

Yellow

Green

Blue

Violet

Brown

Bordeaux

Brick

Dark
Yellow

Dark
Green

Dark
Blue

Purple

Dark
Brown

There’s lots more information on the ColorADD
site, including some great colouring pencils
for colour blind people.

80

Title
Object
Description
Object
Description
Object
Description
Object
Description

Flashing

Users with photosensitive seizure disorders,

than three times a second. For more detailed

such as epilepsy, can have episodes triggered

information have a read of WCAG’s (Web

by flashing at certain frequencies that lasts

Content Accessibility Guidelines) page on the

longer than a short period of time. The basic

“Three Flashes or Below Threshold”.

recommendation is that there shouldn’t be
anything on the screen which flashes more
Pixel Perfect Precision
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Title
ling ticker. Scrolling ticker. Scr

Pixel Perfect Precision

ker. Scrolling ticker. Scrolli

Lorem ipsum dolor sit

Lorem ipsum dolor sit

amet, consectetur

amet, consectetur

adipisicing elit, sed do

adipisicing elit, sed do

Naughty
Movement

Title

Nice

Movement may be problematic for some

elements to stay static, so they have a chance

people, such as those with learning disabilities

to take everything in. If you really need to

or attention disorders, as it can be very

include moving content in your product, then

distracting and breaks their concentration

prevent it from starting automatically and

from information elsewhere on the page.

provide the option to pause or stop, should

Others who can’t read quickly will also want

users choose to press the play button.
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Text to
speech

Testing

Text to
speech

Another piece of general good practice that

how well they’re working. Speaking of real

can be applied to accessibility! Remember to

things, the best tests are with people that

test your app’s accessibility features such as

regularly use these features.

black and white, zoomed view, and text-tospeech. Try them out on real devices, rather
than simulators, as you’ll get a better feel for
Pixel Perfect Precision
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Title
Object
Description
Object
Description
Object
Description
Object
Description

Testing
Colour Blindness
Preview in Adobe
Pixel Perfect Precision

Tucked away in the View > Proof Setup menu
are preview options for the most common
forms of colour blindness — this is a great
way to quickly check if there might be contrast
issues with your chosen palette.
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Title
Object
Description
Object
Description
Object
Description
Object
Description

Testing
Sim Daltonism

Title
Object
Description
Object
Description
Object
Description
Object
Description

Sim Daltonism is a more advanced application

resizable floating window that filters

for checking colour blindness accessibility,

whatever’s underneath the mouse cursor.

featuring previews for most forms of the
condition. Rather than being a Photoshop only
tool, it works across the entire OS, providing a
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DESIGN
DESIGN
AND
AND
DEVELOPMENT
DEVELOPMENT

Design and
Development
Pixel Perfect Precision

Design is only one part of releasing a product,

often produces unsatisfactory results. It’s

equally important is its development. There

much better to work on a problem together as

used to be a distinct barrier between the two

a team, which is the main focus of this

disciplines, with designs being finished then

chapter. Also highlighted are ways to make the

sent off to be built by developers — classic

transition from design to development more

waterfall. But that kind of disjointed process

efficient, saving time and hassle for everyone.
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Essentials
Communication

This first point is an essential part of working

necessary come to a compromise — removing

together. Rather than receiving a product build

a lot of tension in the process. As a certain

that doesn’t look like it was intended, or

advertising campaign used to say: “It’s good

designs that will be far too difficult to

to talk.”

implement, good communication will allow you
to explain your decisions, discuss them and if
Pixel Perfect Precision
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Essentials
Collaboration

Rather than staying in silos and sticking to

have valuable input on what’s technically

your disciplines, try working together a little

possible. In the long run, this means everyone

more. If you’re having a design meeting to

on the team feels more invested in the project

generate ideas, then get the developers on

— which results in a better end product.

your project involved as well. Not only will this
add a different perspective, but they’ll also
Pixel Perfect Precision
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i

Essentials
Learning
Pixel Perfect Precision

i

By working together more closely, you’ll start

learning is more autonomy in decision-

to learn about each other’s disciplines, and in

making. You won’t need to keep asking

particular, any pain points you might have. By

whether your thinking is sound. Instead you’ll

knowing these, you can both take steps to

know enough about what’s possible, or why

reduce them, which will make the project far

something should be a certain way, to make

more enjoyable. An additional benefit of

the choice yourself.
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Button

Essentials
Be Realistic

Button

A frequent sticking point between designers

your designs matched to the pixel, ask

and developers is the difference between the

yourself whether that time could be better

original mockups and the finished app. The

spent improving the app or fixing bugs. It’s no

previous points about teamwork can help get

good having a beautiful product which is

the two closer together, but there should be

difficult to use or keeps crashing.

some realism as well. Instead of trying to get
Pixel Perfect Precision
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640 × 960 326ppi

Preparation
Specifications

Before starting any design work find out as

limitations around interaction or animation

much as you can about the app’s intended

frame rates. The development environment

platform. Screen size is an obvious starting

might also have restrictions in terms of

point, as well as the pixel density, but also

available fonts or rendering effects, so check

track down its bit depth (how many colours

those out too.

the screen can actually display) and any
Pixel Perfect Precision
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Preparation
Deliverables

Part of the specification discovery process is

colours and effects? Do assets need to be 9-

learning what you need to deliver to the

sliced so they’re scalable in the product?

developers, so they can build the product.

Getting hold of this information now means

What format do they need the files in: PNGs,

you can design around any requirements from

PSDs, vectors? If the designs will be rendered

the start.

in code, what limitations are there in terms of
Pixel Perfect Precision

93

Version
Object
Description
Object
Description

Release

Object
Description
Object
Description

Review and Iterate

Preparation
Workflow
Pixel Perfect Precision

In addition to figuring out what you need to

and how are you going to manage sending

deliver, sit down with the developer(s) and

files back and forth? What’s the best way to

discuss how you’re going to work together.

track changes and requests? It’s also

Will the project be waterfall or agile? How

important at this stage to schedule in regular

often will there be builds of the app to look at?

review sessions, so you can both sit down and

What resources do you need from each other,

discuss the project’s progress.
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Preparation
Tracking

PPP–09

Work on translated version

PPP–08

Supply fonts

PPP–07

Create a test build and send to Gyppsy

PPP–06

Squares need to be left aligned

PPP–05

What colour is the text?

PPP–04

Create search results page

PPP–03

Down state for play button needed

PPP–02

Fix bug in playback controls

PPP–01

Supply green square asset

An essential part of the workflow is setting up

any bugs they spot too!). Trying to do this over

some sort of tracking system. Developers will

email is messy, so use something more

want somewhere to request additional or

suitable for the task. This can be something as

missing assets, as well as log bugs, and

simple as a shared to-do list, right up to full-

designers will want to note down any visual

blown project management software.

changes that they’d like updated (along with
Pixel Perfect Precision
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Button

Button

Naughty
Design
Appropriate
Styling
Pixel Perfect Precision

Nice

As part of the project preparations you should

are usually OK, but more advanced effects

have found out any visual limitations, so try to

might not be possible. If in doubt, have a chat

stick to those when creating your designs. Use

with the developer to see what you can and

typefaces that are available on the device, and

can’t do.

keep to styling that can be recreated faithfully.
Simple gradients, drop shadows, and strokes
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Title
Track
Artist

I Love Pixels!
The Pixel Perfecti…

Track
Artist

Line Me Up
The Pixel Perfecti…

Track
Artist

Pixel Monkey
Tony & Dones

Track
Artist

Lean & Agile
The ustwo Band

Naughty
Design
Realistic Content

My Favourites

Nice

To maintain the team’s collective sanity, try to

case scenarios occur, such as too many words

use realistic content in your designs. It’s

or a missing image — you can bet your life

incredibly annoying when you have to go back

they’ll crop up when the app is out in the wild.

and redo everything because there wasn’t
enough room left for an average amount of
text. Also consider what happens when worst

Pixel Perfect Precision
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Layers

Layers

Design

T Title
Background Title
Square Blue
Square Green
Square Orange
Square Pink
Rectangles
Background

Naughty
Design
Keep Everything
Editable
Pixel Perfect Precision

Nice

Design is rarely a one-step process, so keep

created, or because they want to export

your files editable — that way you can quickly

assets themselves.

make changes and updates. It’s also very
useful as sometimes developers will want the
source files to see how a design’s been
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Active
Button

Selected
Disabled

Naughty
Design
Object States
Pixel Perfect Precision

Nice

Remember to design and deliver the different
states for objects and export them all at the
same size, so they’re aligned and pixel perfect.
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#15d0d4

Secondary Colour
#757575

Active

Px Grotesk Light 36pt #15d0d4

Subtitle Text
Px Grotesk Light 36pt #757575

Body Text Colour

Body Text

#333333

Px Grotesk Light 14pt #333333

Design
Style Guide
Pixel Perfect Precision

Title Text
Divider Line 2px #999999

Accent Colour

Selected
Disabled

Style guides are a really handy resource to

as the master document for all the project

have on a project, since you can gather all the

assets and styles, you'll no longer need to go

various assets and styling in one place, see if

through every single screen mockup making

everything looks consistent and then send off

tiresome changes. Whatever's in this bible is

to the developer as a reference guide. Also, if

correct and variations elsewhere can be

this file is kept up to date and you both use it

ignored. It's liberating.
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Title
Object
Description
Object
Description
Object
Description
Object
Description

Design
Design in Code

.square_pink {
background-color: #ed0082;
position: absolute;
left: 32px;
top: 128px;
width: 96px;
height: 96px;
}
.rectangle {
background-color: #e8e8e8;
position: absolute;
left: 32px;
top: 128px;
width: 96px;
height: 96px;
}

One way of making sure that everything looks

on your way to making simple interactive

and works how you want it to, is designing in

prototypes in HTML — designs really start to

code. You could write this from scratch, but it

come to life once you can play around with

might be quicker to create a mockup as usual,

them on a device.

then export the layers and styles directly to
CSS. Once that code’s generated you’re well
Pixel Perfect Precision
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Colour Profile

Yes

No

Code

Naughty
Design
Colour Profiles
Pixel Perfect Precision

Nice

As mentioned in other chapters, avoid using
colour profiles as they can cause mismatches
between assets and code.
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= Deadline

Naughty
Delivery
Timing

Nice

Try to deliver work on time, not only does it

change in schedule. Chances are it won’t be a

create bad feeling when people miss

problem and they can work on something else

deadlines, but you could also become a

in the meantime.

bottleneck in the project. If something’s taking
longer than expected, then speak to the team
in advance so everyone can adapt to the
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Project
Rectangle.png
Square.png
Square copy.png

Project
Design
Screen.psd
Assets

Square copy 2.png

Rectangle.png

Square copy 3.png

Square Blue.png

Untitled.psd

Square Green.png
Square Orange.png
Square Pink.png

Delivery
Organisation

Keeping your project files organised will make

example Photoshop layers) as other people

the transition from designer to developer (and

might want to work on them.

back again) far more efficient. Name and
structure everything logically and consistently,
using a system that you both understand. This
also applies to the content within files (for
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Delivery
Naming Systems

The naming system you use plays a large part

Then add the unique identifier, as an example,

in setting up a good organisational structure.

buttons on the home screen which create and

At the start of the project speak to the

delete documents would be called:

developer about the best way to name files, as
they often have a preferred method and then

btn_home_new

btn_home_delete

adapt it over time if needed. A good approach
is to base your naming on a hierarchical

Finally, if the component has multiple states

system, which starts off with a broad

then add them to the end:

identification of the component and then
progressively adds more information. So you

btn_home_new_default

might end up with a structure like this:

btn_home_new_highlighted

type_location_identifier_state

As an aside, the system shown here uses
lowercase letters and underscores instead of

The type refers to the category the component

spaces in the names, which is our usual

belongs to, such as:

choice. Another method is CamelCase, which
uses no spaces and instead capital letters to

bg

(background)

icn (icon)

btn (button)

define each part of the structure:

img (image)
BtnHomeNewDefault

The next step is to add the screen or location

BtnHomeNewSelected

where this component appears (global means
it’s used across multiple sections):
bg_help

Pixel Perfect Precision

btn_home

icn_global
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Delivery
Naming Systems
icn_global_signal_full
btn_global_menu_default

icn_global_battery_full

Title

btn_home_play_pink_default

Object
Description

btn_home_play_orange_default

Object
Description

btn_home_play_green_default

Object
Description

btn_home_play_blue_default

Object
Description

Pixel Perfect Precision

btn_global_search_default

bg_home_description
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Naughty
Delivery
Don’t Compress
Assets
Pixel Perfect Precision

Nice

When exporting assets keep them in
uncompressed formats like PNG, as
development environments will often apply
their own compression anyway.
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Title

Title
Object
Description
Object
Description

Object
Description

Title

Movie.avi

Object
Search results

Object
Description

Object
Description

Object
Description

Object
Description

Object
Description

Object
Description

Watch me!
I’m going to move
Static
I don’t move

Title

Object
Description

Object
Description

Object
Description

Lorem ipsum dolor sit
amet, consectetur
adipisicing elit, sed do
eiusmod tempor incididunt
ut labore et dolore magna
aliqua. Ut enim ad minim
veniam, quis nostrud
exercitation ulamco laboris
nisi ut aliquip ex ea.

Delivery
Specifications

Movie

Static
I don’t move
Static
I don’t move

When sending designs over to developers, try

incredibly useful. As are movie clips showing

to include as much useful information as

the desired speed and style of motion.

possible. Lengthy documents listing all the
measurements on each screen will probably
be ignored, but flows and prototypes that
demonstrate how an app works can be
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Assets
Object States
Style Guide
Flows
Check Again

Delivery
Check! And Then
Check Again!
Pixel Perfect Precision

Before sending off a delivery to the developer,
check through to see if you’ve included
everything they need and then check again
just to make sure!
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PHOTO
SHOP &
USTWO
Now that we’ve covered a lot of design principles, let’s dive into
some specifics. Photoshop is our day-to-day tool here at ustwo,
and across the industry as a whole, so knowing how to use it
properly is pretty essential. The following sections show you some
of the methods and techniques we use…
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Photoshop

COLOUR
PROFILES

System Settings

To avoid any nasty colour jumps between
Photoshop and Mac OS X, your colour settings
need to be set up correctly. The first thing to
do is make sure System Preferences >
Displays > Color is set to the device you are
currently using — in this case Color LCD.

Pixel Perfect Precision
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Photoshop Colour
Settings
Pixel Perfect Precision

Next, in Photoshop, go to Edit > Color
Settings… and change Working Spaces > RGB
to Monitor RGB – Display. Also change Color
Management Policies > RGB to Off.

113

Photoshop Save
for Web
Pixel Perfect Precision

Additionally, in Save for Web the Convert to
sRGB option needs to be deselected, and
Preview should be set to Monitor Color. Your
colours should now be consistent.
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Color Faker

Although following the previous advice will

handles profiles. For an in-depth explanation

give you the correct set up for day-to-day

read this article on OS X Color Meters and

tasks in Adobe products, you may need to take

Color Space Conversion, but the long and

an additional step if you’re having trouble with

short of it, is that you should download Color

colour values in Apple software like Xcode or

Faker and switch it on!

Keynote. This is down to the way that OS X
Pixel Perfect Precision
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Photoshop

PIXEL
PRECISION

Naughty
Shape Layers

Nice

We love Shape Layers here — our workflow is
almost entirely based on them. Being vectors,
they’re completely editable, allow scaling and
transformation of the shape with no loss in
quality, and are less resource hungry than
Smart Objects or bitmaps. Winner.
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Naughty
Shape Layers
Other Vectors

Nice

Also, try to use vectors for other parts of your

added advantage that the fill will

design where you might instinctively use a

automatically scale if the canvas size is

bitmap, for example layer masks, as this will

increased. Nice.

further increase the versatility and speed of
the file. Another related tip is to use unmasked
Shape Layers for backgrounds, which have the
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Naughty
Shape Layers
Performance

Nice

As an illustration of the performance hit that

version takes up around five times the amount

bitmaps create, take a look at the two values

at 3.47MB! On larger files you can save

highlighted above. These are document size

yourself hundreds of Megabytes of memory.

readouts for the layers featured on the
previous page. The vector design only uses
113.9KB of memory, but the all-bitmap

Pixel Perfect Precision
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Live Shape
Properties
Pixel Perfect Precision

Photoshop CC has an awesome new addition

or change one or all of the corner radii? Just

to the Properties panel: Live Shape Properties.

select the shape and adjust the values. Also,

Any new Shape Layer now has a set of

unlike in previous versions of Photoshop, when

measurements that can be adjusted after it’s

you hit transform and resize a shape, the

been created, which is great for getting pixel

corner radii are now preserved rather than

perfect dimensions and positions. Need to add

being distorted. Time saved = loads.
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Corner Editor

If you’re using a version of Photoshop prior to

you can even have different sizes for each

CC, then there is still a way to edit corner radii

corner, just like in CC. There’s also the option

after you’ve drawn a shape: Corner Editor.

to use different styles, so you’re not just

With it installed, you can select a Shape Layer,

limited to rounded corners.

bring up the window above from File > Scripts
> Corner Editor, and change the radii value —
Pixel Perfect Precision
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Layer Effects

Another thing we love here are Layer Effects,
so we try to create as much styling as possible
with them. The effects are completely editable,
scalable in ratio to their underlying shapes,
and can be copied and pasted to other layers.
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Linked Smart
Objects
Pixel Perfect Precision

Linked Smart Objects work in a similar way to

updates to these source files propagating to

regular Smart Objects, except that they

every design that references them — very

reference external files for their content. This

powerful. Setting up a Linked Smart Object is

opens up the potential for a team of designers

dead simple — just choose Place Linked…

to use the same common library of interface

from the File menu and select the object you’d

components across an entire project, with any

like to import.
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W : 160 px
H : 160 px

Some Text

Info Panel

Fire up the Info Panel when the cursor readout
just isn’t enough. Not only does it show
detailed measurements, but it can also be set
to display colour and opacity values amongst
other things, allowing you to quickly check
consistency throughout a design.
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Snap to Pixel Grid

With Photoshop CS6 and above there’s a

every Shape Layer you draw will automatically

global option to snap vectors to pixels in the

be pixel precise.

Preferences — just make sure Snap Vector
Tools and Transforms to Pixel Grid is selected
(it’s on by default). Much easier knowing that
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Snap to Pixel Grid
Shortcuts

There may be times when you’d like to alter

Function Key shortcut to it, hit Record, and

Shape Layers on a sub-pixel level, in which

then go in to the preferences and switch Snap

case you won’t want pixel snapping activated.

Vector Tools and Transforms to Pixel Grid on.

If you often find you want to toggle the feature

Afterwards follow the same steps for off. No

on and off like this, then why not automate the

need to hit the Preferences any more.

process? Simply create a new Action, assign a
Pixel Perfect Precision
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Shape Layer
Options

In Photoshop CS5 Rectangles and Rounded

Rounded Rectangle, as their options are

Rectangles have a built in option to aid pixel

independent of each other.

precision: Snap to Pixels. To access this option
click the drop-down menu to the right of the
shapes in the top tool bar. This needs to be
individually selected for both Rectangle and
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Nudging

Pixel Perfect Precision

If you’re zoomed into a design in Photoshop

in at 200% the points will only move 0.5px (i.e.

CS5 be careful when using the keyboard to

half the amount), creating blurred edges —

shift points of a Shape Layer — the nudge

not good. With CS6 pixel grid snapping the

amount varies according to the zoom factor.

points move 1px no matter what the zoom

To guarantee a 1px movement, zoom out to

level. You’ll need to switch off the snap to

100% and press the arrow key once. If zoomed

move by smaller increments though.
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Snapping

Photoshop has lots of handy tools to help with

which really helps with alignment. The Snap To

pixel precision. One of the first things you

submenu allows you to alter the various items

should do when setting up the program is

that Photoshop can use for snapping.

enable snapping — go to View > Snap and
make sure it’s active. Now your objects will
snap to other items and guides on the canvas,
Pixel Perfect Precision
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Align and
Distribute
Pixel Perfect Precision

As with most graphics applications,
Photoshop has and abundance of align and
distribute options — find them in the Layer >
Align and Layer > Distribute menus.
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Grids

Sometimes it’s useful to have a grid on screen

to Photoshop > Preferences > Guides, Grid, &

when laying out a design. The example above

Slices… to set yours up.

is using 10px gridlines with 10 subdivisions,
making it easy to count pixel dimensions
without the grid becoming overpowering. Go
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Some Text

GuideGuide

Pixel Perfect Precision

To help automate guide creation, there’s a free

widths, or if you’ve already sussed these out

Photoshop Extension available called

on a scrap of paper, you can just input all the

GuideGuide. Once installed it can be found in

values and get your guides inserted

the Window > Extensions menu. By varying

automatically. There are tooltips for each of

the data you enter it can work out

the input box icons to let you know what they

measurements such as column and gutter

all do.
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90°

drag to new
document

120°

Global Light
Default Angle

This is one of those little things that can catch

close all your open files and go to Layer >

you out if you’re not careful. Objects that have

Layer Style > Global Light… to alter the default

a custom Global Light setting will take on the

angle to something more commonly used —

default value of 120° if they’re copied into new

90° works well for us.

documents, which can really mess designs up.
To help prevent this from happening too often
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133

Some Text

Live Previewing

Some Text

Test, test, test again, and then test some

saving out files and then copying them across

more! One of the best things you can do is

to a phone. A couple worth checking out are

look at your designs on the device(s) they’re

Skala Preview for iOS (and now Android) and

intended for. There’s lots of software out there

Android Design Preview for… well you can

which will give a live preview straight out of

guess that one!

Photoshop, so there’s no need to faff around
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Photoshop

TECHNIQUES

Some Text

Naughty
Object Colours

Nice

With Shape Layers and text it’s a good idea to

object easier to find in the Layers panel. As an

change the colour using the object’s own

example, how quickly can you locate the blue

setting, instead of the Color Overlay Layer

square in each of the examples above?

Effect. The benefits of this are a) there’s no
need to load up the Layer Style window if you
want to change the colour, and b) it makes the
Pixel Perfect Precision
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Some Text

Naughty
Object Gradients

Pixel Perfect Precision

Nice

Same thing with gradients — use a gradient
fill layer instead of a Layer Effect if possible.
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Object Gradients
Dither

Whichever gradient method you choose, make
sure the Dither option is selected. This will
help smooth out the colour transition and
prevent any banding. With Photoshop CS5 you
can only apply a dither to a gradient layer, but
in CS6 and above it’s possible for both.
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Naughty
Concise Layer
Styles
Pixel Perfect Precision

Nice

Try not to spread the Layer Effects for an
object across multiple layers. It’s much better
if they’re all together, as it keeps things tidy
and makes it easier to copy and paste styles.

139

Scale Layer by 200%

Scale Effects by 200%

Scale Layer
Effects
Pixel Perfect Precision

Although you can choose the Scale Styles

but you can use the Scale Effects… option to

option when you resize an entire document

change them as well — although you’ll need

through Image Size… there are times when

to know the percentage increase/decrease of

you want to scale individual layers and their

the original shape to get the two to match.

effects. When you resize one of these objects,

This option can be found by right-clicking the

the styling doesn’t automatically adjust with it,

fx icon on the layer in question.
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Layer Effect
Strokes
Pixel Perfect Precision

At first glance it may seem that the only way to

outlines. The Stroke will always appear on top,

create a stroke with Layer Effects is the Stroke

followed by Inner Shadow and Inner Glow on

option, but in fact there are multiple ways to

the inside, likewise Outer Glow and Drop

add them to a shape. If you use the Inner/

Shadow on the outside. Downsides? At thicker

Outer Glows and Shadows, and set their

widths they can blur, and the Choke can cause

Choke to 100%, you can also get solid

roughness on rounded edges.
141

Naughty
Layer Effect vs.
Vector Strokes
Pixel Perfect Precision

Nice

If you want top quality outlines, and have

bevelled edges, as well as dashed outlines.

Photoshop CS6 or above, then add a vector

They can also be scaled to half pixels, which is

stroke directly to your Shape Layer rather than

really useful if you’re designing for iOS, as you

as a Layer Effect. Not only are they better

can set a non-Retina stroke to 0.5px which will

quality (more noticeable at thicker widths), but

then scale up to 1px when the size is doubled

you have the option to use rounded, square, or

to Retina.
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Complex Vectors

If you want to draw complex vectors, it’s often

yourself: “Don’t be a joke, outline the stroke”. If

easier to use Illustrator than copy and paste

the vector is more than just a shape, for

the outline into Photoshop as a Shape Layer.

example a multi-colour desktop icon, then it

Make sure you outline any strokes in the

will have to be pasted as a Smart Object.

Illustrator original, otherwise they won’t import
properly. Remember by reciting this phrase to
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Naughty
Pasting From
Illustrator

Nice

One quirk of pasting Shape Layers from

Always check to see if this has happened, and

Illustrator is that it can sometimes shift the

if it has, shift the shape back by half a pixel to

object off-centre by half a pixel in either or

its intended position.

both axes, resulting in blurred edges —
although with CS6 onwards and pixel
snapping this seems to be less of an issue.
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Naughty
Blending Modes

When creating effects remember to only use

the blending effect disappears and it becomes

blending modes on items which will later be

a white to black gradient.

merged with other layers. In the example
above the Highlight layer will be exported as a
separate asset, but when shown on its own,
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Nice
Blending Modes

The best solution is to recreate the effect
using a layer that’s independent of what’s
underneath it.
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The original line of text

Replacement text

Naughty
Text Alignment

The original line of text

Replacement text

Nice

When adding text, make things easier in the
future by matching the paragraph alignment
to that in the design — if the text is then
changed, it will still look correct.
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Naughty
Paragraphs

Nice

If you’ve got a paragraph of text, then place it

though, the text will automatically wrap,

in a container (Paragraph Text) rather than

making the paragraph easier to update.

manually adding line breaks (Point Text). These
will often have to be reset if the copy or
typeface is changed. With a proper container
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Convert to
Paragraph Text

Fortunately, Photoshop allows you to convert

Photoshop CS5 these are found in the Layer >

Point Text to Paragraph Text, and vice versa,

Type > menu.

by selecting Type > Convert to Paragraph Text
/ Convert to Point Text, or right-clicking the
layer and choosing the same option. In
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Naughty
Hyphenation

Pixel Perfect Precision

Nice

Most devices don’t support hyphenation, so
for accuracy leave it out of your designs.
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Naughty
Leading

Nice

Photoshop’s default leading is just a bit too
tight for comfort, so make your text easier to
read by spacing it out a little bit. See how
much better the Nice example above is after
increasing from the (Auto) setting to 20pt.
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Crisp
Text Anti-aliasing

None

Sharp

Strong

Smooth

There are a few different types of text anti-

option which is the closest match to the

aliasing in Photoshop, so try them out to see

intended screen’s anti-aliasing.

which gives you the most suitable legibility
and rendering — Crisp seems to be a good
all-rounder. Similarly, if you’re mocking up text
that will be generated elsewhere, then find the
Pixel Perfect Precision
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Mac LCD

Text Anti-aliasing
System

Mac

Photoshop CC also includes anti-aliasing

RGB. For a little extra detail on these new

options that replicate the operating system’s

rendering options, have a look at Realmac

sub-pixel rendering, giving you a good idea of

Software’s Working with Type in Photoshop

how text will look in a browser for instance. It’s

blog post.

worth noting though that unlike browsers, the
sub-pixels in Photoshop are greyscale, not
Pixel Perfect Precision
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Some Text
Some Text
Some Text
Some Text

Naughty
Lists

Nice

When creating lists, especially those with

content perfectly aligned and distributed, but

graphics next to them, you might find it easier

it’ll be quicker to update in the future.

to place all the descriptions in a single text
block and set the leading to the spacing
you’re after, rather than have each line as a
separate layer. Not only will it keep the
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Some Text

Some Text

Quick Preview

Mobile phone screens often have a higher

out until your document roughly matches the

pixel resolution (PPI) than those on computers,

measurements of the phone screen — if

meaning the physical dimensions of your

anything looks too small make it bigger!

designs will be smaller on the former than the
latter. As a quick check to see if text and
interactive elements are a useable size, zoom
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Photoshop

ORGANISATION

Layers Panel
Options

By default, Photoshop will add “copy” to the

Add “copy” to Copied Layers and Groups.

end of every duplicated layer’s name — very

Every little helps.

annoying. To switch this feature off, and also
remove some other visual clutter, go to the
Layers Panel Options and untick Use Default
Masks on Fill Layers, Expand New Effects, and
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Some Text

Naughty
Naming Layers

Nice

Don’t be selfish, give your layers proper

created so you don’t need to rush and do

names. Not only does it make life easier for the

them all at deadline time.

next person who has to work with your files,
but clients will think you’re amazing if you
send off something that’s really well
organised. Pro tip: name your layers as they’re
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Before
Group Layer
Renaming

After
If you’d like to do some batch renaming then
download this Group Layer Renaming script
by Kamil Khadeyev. It does exactly what it
says on the tin, letting you add text or
completely rename layers, as well as attach
sequential numbers using the %n variable.

Pixel Perfect Precision

159

Some Text

Naughty
Ordering Layers

Nice

To make your files super special, be sure to

book (apologies if your first language goes in

order your layers logically in addition to

another direction).

naming them. A good method is following
where the elements appear in the design from
left to right, top to bottom, just like reading a
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Some Text

by Name
Search

Pixel Perfect Precision

by Kind

Coupling good organisation and the search

content — perfect for situations like updating

features available in Photoshop will give you

multiple buttons with a new style. There’s lots

an incredibly powerful way of working with

of other search types available, including Kind,

your designs. For example, by naming layers

Effect, and [Layer] Colour, so have a play and

consistently with prefixes such as “btn”, “icn”

see what other filtering systems you can come

etc. you can quickly filter them by their

up with.
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Grey (“neutral”) used for
reference items like
wireframes or screenshots

Red (“danger”) for old,
unused elements

Popup window

The green labels highlight
different states of the
same button

Core design doesn’t
have colour labels

Colour Coding

Here’s an example of colour coding layers so
they’re easier to navigate. Try to leave the core
design untouched though so the panel doesn’t
end up looking like a bag of Smarties. Right
click on a layer to choose a colour label.
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Naughty
Expanded Layer
Effects
Pixel Perfect Precision

Nice

Like a messy house guest, expanded Effects
can make it harder to find the things you’re
actually after. Keep them collapsed and life
will be better for everyone.
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Naughty
Delete All Empty
Layers

Nice

Try not to leave empty layers or groups
scattered throughout your files, as they add
unnecessary clutter. There’s a handy script
located in the File > Scripts menu called
Delete All Empty Layers which does it exactly
what you think it will.
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Before
Remove Unused
FX

After

If you’re experimenting with a design you can
often end up with lots of unused effects
floating around. You’d normally have to delete
them one by one, but with the Remove
Unused FX extension installed, they can all be
gone at the click of a button.
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Naughty
Locked Layers

Nice

Locks are a great way to protect an object
while you’re working, but make sure they’re
switched off before handing the file over to
other designers. A locked layer hidden deep
within a file is a pain when it prevents you from
moving or deleting a group.
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Layer Comps

Some Text

Some Text

Some Text

Some Text

Some Text

Some Text

Layer Comps are a really useful way to store

and even modify the position of an object.

multiple variations of a design within one file.

Remember to save your changes to a comp by

At a basic level they allow different layer

hitting the update button.

visibilities to show and hide content in
different configurations, but there’s also the
option to toggle individual Effects on and off,
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Photoshop

EXPORT

Generator

Pixel Perfect Precision

Generator is one of the best new features in

when any changes are made to the source file

Photoshop CC, allowing you to export layers or

— woohoo! There are also various parameters

groups by simply adding a file extension to

available that can scale and/or adjust image

their name. Once activated from the File >

quality, as well as output multiple versions of

Generate menu it will run through and create a

the same asset. Check out this Generate

folder of assets, automatically updating them

image assets from layers page for more info.
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Export Scripts

Pixel Perfect Precision

There’s still a way to automate asset export if

as its own layer or group, and give it an asset

you’re not using Photoshop CC. Instead use

name. It doesn’t matter how many layers a

our ustwo Crop & Export scripts (see next

group contains, as the scripts only work at the

page for details). The first thing you need to do

root level. Also, by laying out the components

is set up your files so they work properly, put

separately, as shown above, you’ll end up with

every individual object that you want to export

a useful reference sheet.
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Export Scripts

Now that your file’s sorted, use one of our

ustwo Crop & Export +1px [layername]

scripts to export all the individual assets as

Same as the previous script, just using the

PNGs… no muss, no fuss. Just copy them from

alternative naming method.

Scripts in the PPP Extras to your Adobe
Photoshop CSx/Presets/Scripts folder,

There are also a couple of additional scripts

(re)start Photoshop and you’re good to go.

which won’t crop the layers but will instead

Once installed they can be accessed from the

stick to the dimensions of the Photoshop file.

File > Scripts menu.

This can be useful for things like screen
comps, where the actual content might

ustwo Crop & Export [filename][layername]

change size, but you want all the exported

This will crop to each asset and then export

PNGs to have the same dimensions.

the file as [filename][layername].png, meaning
a layer called _normal from button.psd would

ustwo Export [filename][layername]

end up as button_normal.png.
ustwo Export [layername]
ustwo Crop & Export [layername]
Same script as above except it doesn’t add
the filename, so the layer from the previous
example would export as _normal.png.
ustwo Crop & Export +1px [filename]
[layername]
In this case the asset will have a 1px margin
added to each edge so that it’ll display
correctly in Flash. File naming works as with
the normal Crop & Export.
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Save for Web

Check out the difference in file size for the two
different PNGs here. Save As… has created a
file that’s 32KB bigger than Save for Web.
Worth using the latter then.
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Reducing File Size

If you’re exporting an asset that doesn’t need
transparency, try converting it to an 8bit PNG.
In the example above there’s no loss in quality
from making the switch, but the file size has
been more than halved.
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ImageOptim

ImageOptim can shave even more Kilobytes

and colour profiles, as well as optimising the

from your assets. Simply drag and drop your

compression used. Worth noting though, that

files on to the main window and watch as it

if you’re developing for iOS, then it might not

does its thing. The app works on PNG, JPEG,

be worth using ImageOptim, as this article on

and GIF images by stripping out any

PNG compression and iOS apps explains.

unnecessary metadata, such as comments
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Reducing
Photoshop File
Sizes
Pixel Perfect Precision

A quick way to knock some of the size from

compression as PSDs can shrink down to less

your PSDs is to hide all the layers. Not always

than 10% of their original size.

practical if a design requires a certain visible
combination to make sense, but it can be
useful if you’re sending files and want them as
small as possible. Even better, use ZIP
175

565

Pixel Perfect Precision

Some devices can’t display as many colours

plugin. This reduces the bit depth from 24 bit

as your computer screen, which may cause

to 16 bit (a commonly supported amount on

visual degradation of your assets — often

older mobile screens) and applies dithering to

most noticeable in gradients and transitions.

counteract the reduction in colours. The 565

To prevent this from happening convert them

name comes from the 5+6+5 bits per channel

to 565 images using the Ximagic ColorDither

of a 16 bit RGB image.
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565
Batch
Pixel Perfect Precision

Running the 565 filter on a group of files is

option than Save and Close in the Destination

pretty laborious if you do them all individually,

menu, which increases the file size), and

so automate the process using Actions and

closes the file without saving. Afterwards,

the Batch tool. Output all the assets as usual,

simply run the Action in the Batch tool with the

then record an Action that applies the filter,

settings as above. All the filtered files will be

exports the result using Save for Web (a better

exported to the original Save for Web folder.
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Photoshop

TIPS

No Glow

Glow
Strokes

Occasionally 1px strokes can look a little too
thin and wispy on curved edges. To strengthen
them without increasing their thickness add a
Glow using the settings above. The difference
is subtle, but it definitely helps.
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Fading Circles

Circular fades are really easy to make with the
Stroke Effect. The trick is to use Fill Type:
Gradient and Style: Angle.
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Quick Shine

If you want to quickly add a shine to an object,
try using the Inner Shadow Effect with a low
opacity white. Be careful though, as its shape
will be based on the top edge of the parent
layer, meaning any non-straight sections will
be replicated in the shine.
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Add Noise with
Inner Glow
Pixel Perfect Precision

It’s possible to add a simple noise texture to
an object using the Inner Glow Effect. Set the
Source to Center and Size to 0, then vary the
amount using the Noise setting.
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Grab a flat bitmap logo on a white

Image > Adjustments > Invert then Select

background from somewhere

All and Copy

Create a new Solid Color layer, add a Layer
Image > Adjustments > Desaturate

Mask, Option + click on it and then Paste —
this masks the layer using the black and
white logo you copied in the previous step

Image > Adjustments > Levels and
use the black point eyedropper to
select the main grey colour

Extracting Logos

Ta-da! You now have a logo on a
transparent background

Sometimes it can be difficult to obtain a

open these up in Illustrator and grab any

decent copy of a logo, in which case try using

vector logos they might contain.

this process as a last resort. Another useful tip
is to search a company’s site to see if they
have any PDFs available for download. You can
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Star Fields

Play around with the settings in the Brushes
panel to create some different effects, for
example a basic star field. By increasing the
Size Jitter and Opacity Jitter the brushes
become more random.

Pixel Perfect Precision

184

Patterns

Pixel Perfect Precision

Add a little something to your designs by

pattern can then be used throughout the app,

including a pattern or texture. They’re simple

including the Layer Style panel. Don’t just add

enough to make in Photoshop: first, draw a tile

it on top of everything else as a solid layer

that seamlessly repeats, then drag a selection

either. Experiment with Blend Modes and

around it, and finally go to Edit > Define

Opacity to change how the pattern interacts

Pattern… to save it as a preset. The new

with the underlying design.
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Kuler

Feeling a bit uninspired when it comes to
colours and palettes? Then give Kuler a go.
This handy Photoshop extension allows you to
browse through and interact with usergenerated colour schemes, as well as create
your own. Beautiful!
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Character Viewer

Pixel Perfect Precision

Mac OS X includes a couple of helpful type

known glyphs in a typeface. To use it, make

tools, found in the menu bar option that

sure you’ve got a text box active in Photoshop

appears after activating Show Keyboard &

(or any other app) and double-click the

Character Viewers in menu bar in System

character you want to insert. If nothing

Preferences > Keyboard. The first in the pair,

appears it means the typeface you’ve got

Character Viewer, will help you find lesser

selected, doesn’t have that option available.
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Keyboard Viewer

Character Viewer’s little brother is Keyboard

other options available. It’s a great way of

Viewer, a simpler app that shows you all the

learning how to type accents and symbols

letters and symbols available from the

directly from the keyboard.

keyboard. Clicking on a key with a text box
active, inserts that character; hold down
modifiers like Shift and Option to see all the
Pixel Perfect Precision
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Shortcuts
Paths

There are loads of shortcuts available for the

down Shift; alternatively − (minus) or Option

path tools to speed up their operation.

will subtract from the shape. Once drawn, add

Combine the paths of two existing Shape

and subtract the new path from the original by

Layers by selecting them and hitting

selecting it and pressing – (minus) or + (plus).

Command + E. After drawing a path, add
another to it by pressing + (plus) or holding
Pixel Perfect Precision
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Some Text

Shortcuts
Paths

If you’re editing a path with the Direct

Command + Shift + H will hide the current

Selection Tool and don’t want to accidentally

selection, useful for previewing the shape

select other Shape Layers in the document,

without the path obscuring the edges.

then tap Q to enter Quick Mask Mode, which
isolates the one you’re currently working on.
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Some Text

Shortcuts
Paths

Some Text

Photoshop CC includes updates to the way the

one shape at once. Double-clicking on a path

Direct Selection tool interacts with paths,

will isolate it, with another double-click exiting

making them easier to edit. With Select: All

that mode.

Layers chosen in the Options bar you can now
click and drag to select multiple points over
multiple layers, allowing changes to more than

Pixel Perfect Precision

191

Shortcuts
Selections and
Brushes
Pixel Perfect Precision

When creating a selection, hold down the

Use the square bracket keys, [ and ], to adjust

Space key to move its original point around.

the brush size up and down. Shift + [ or ] will
increase or decrease the brush hardness.
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Shortcuts
Layers
Pixel Perfect Precision

Select a layer and press the forward slash /

Collapse or expand all layer sets in a

key to lock its transparency. On Shape Layers,

document by holding down the Command key

this will lock the position instead.

and clicking on one of the accordion icons.
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Shortcuts
Layers
Pixel Perfect Precision

To hide all but one layer, hold down Option

To show or hide layers in a row, click, hold

and click its visibility icon.

down, and drag the cursor across all the
relevant visibility icons.
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Shortcuts
Keyboard

Cycle screen modes (F)

Move selection outline (Shift + Arrow keys)

Switch between normal, fullscreen with task

Moves selection outline by 10px.

bar, and full screen with black background.
Move selection (Command + Arrow keys)
Hand tool (Space)

Moves selected layer or area by 1px.

Temporarily selects the hand tool while held
down, use to pan around an image.

Move selection
(Command + Shift + Arrow keys)

Cycle open documents (Command + `)

Moves selected layer or area by 10px.

Acts like Command + Tab in the OS,
navigating between open documents.

Select all layers (Command + Option + A)
Selects all layers in the Layers panel.

Canvas background (Space + F)
Cycles through canvas colours.

Load layer as selection
(Command + click layer thumbnail)

Switch colours (X)

Load layer transparency as a selection.

Flips the foreground and background colours.
Enable/disable layer mask
Default colours (D)

(Shift + click layer mask)

Resets foreground and background colours to

Switch layer mask on and off.

black and white.
View mask (Option + click layer mask)

Pixel Perfect Precision

Move selection outline (Arrow keys)

Show the layer mask as a separate image,

Moves selection outline by 1px.

which can be edited like a channel.
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Shortcuts
Keyboard

Load mask as selection
(Command + click mask)
Loads up the mask as a selection.
Invert selection (Command + Shift + I)
Inverts the selection, so previously selected
areas become deselected and vice versa.
Deselect (Command + D)
Removes current selection.
Reselect (Command + Shift + D)
Reloads the last selection.
Copy layer (Command + J)
Duplicate the currently selected layer.
Change layer opacity (1–0 keys)
Adjust the layer’s opacity in 10% increments.
Cycle blending modes
(Shift + + (plus) or − (minus))
Cycle through layer blending modes.
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Keyboard
Shortcuts and
Menus
Pixel Perfect Precision

Become a Photoshop lean machine by

interface design tasks. Another really neat

creating custom keyboard shortcuts with the

thing to do is remove the Command + Q

Edit > Keyboard Shortcuts… dialog. The

shortcut to prevent yourself from accidentally

window above shows a couple of new ones

quitting Photoshop.

assigned to Align > Vertical Centers and Align
> Horizontal Centers, which are common
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ILLUSTRATOR

Introduction

Illustrator: deploy when Photoshop’s vector
tools just aren’t quite up to the task. We tend
to use it for creating complex shapes which
are then styled in Photoshop. That way they
retain their versatility but have access to a
wider range of effects.
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Illustrator Colour
Settings

It’s worth setting up Illustrator’s colour profiles

RGB – Display and Color Management

properly as well. For example, you might want

Policies > RGB is Off.

to add some colour to vector sketches which
match a design in Photoshop. As with its
sibling, go to Edit > Color Settings…, make
sure Working Spaces > RGB is set to Monitor

Pixel Perfect Precision

200

Preferences

There’s a couple of changes you can make in

to the Units section and set General and

Illustrator’s Preferences to improve its pixel

Stroke to Pixels, which means all your

precision. The first, is setting the keyboard

dimensions will now be pixel-based. Since

increments to 1px so the cursor keys will

digital type is often still measured in Points —

nudge shapes and points around by whole

that setting remains untouched.

pixel measurements. Once this is done, switch
Pixel Perfect Precision
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Grids

As with Photoshop, you might find it useful to
set up a grid based on 10px gridlines with 10
subdivisions. These settings can be found in
Preferences > Guides & Grid.
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Snap to Grid

Yup, you guessed it, switch Snap to Grid on
here too! Just like Photoshop’s version, it’s
located in the View menu.
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Smart Guides

Sometimes you need to rebel and break out of

underneath it as shown, switching on Smart

the pixel grid. On these occasions, Smart

Guides, and then selecting the circle — the

Guides provide a handy alternative form of

Pen tool can snap to the precise location

snapping. In the example above an extra

where the two shapes intersect and add an

anchor point is needed at the 45° position on

anchor point there.

the circle. By placing a right-angled triangle
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Naughty
Precision

Nice

The Transform window is a pixel precisionist’s

dimension will adjust the other by the same

best friend. With it you can check if a whole

factor, keeping the object in proportion.

shape (top row), or a single point (bottom row)
are perfectly sized and/or positioned. Also, by
using the link option for the W and H boxes,
any transformation you make to one
Pixel Perfect Precision
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Align to Pixel Grid

The new super-villain of Illustrator! Make sure

these settings). When active this feature

Align New Objects to Pixel Grid is switched off

aligns objects to the underlying pixel grid,

in the Transform panel menu, and for any

which sounds perfect until you realise it can

existing shapes Align to Pixel Grid is

unexpectedly start shifting objects around

unchecked when they’re selected (choose

when strokes are added.

Show Options in the panel menu to display
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Pixel Preview On
Pixel Preview

Pixel Preview Off

This is another feature to be wary of. When
View > Pixel Preview is active, shapes which
may not be pixel precise can be displayed as if
they are.
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Preview Blurring

Nothing to worry about too much here, but

blurring doesn’t appear when the shape is

sometimes Illustrator will render a shape with

imported into Photoshop.

blurred edges even though the dimensions are
on pixel in the Transform window. This seems
to be a bug with the program. Thankfully the
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Organisation

It’s not really worth naming every layer in
Illustrator if you’re just using it to draw shapes,
but at least try to organise everything into
groups rather than spreading it all out over an
area the size of a football pitch!
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APPENDIX

PPPatterns

The PPP Extras include a simple pattern library
for you to play with, available as Photoshop
presets (Patterns/PPPattern.pat) or preapplied Effects (Patterns/PPPattern.psd).
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